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HUD COMBINED HEAT AND POWER (CHP) GUIDE #3 

LEVEL 2 ANALYSIS TOOL FOR MULTIFAMILY BUILDINGS1

 
 

I. INTRODUCTION AND SUMMARY 
Promoting the use of combined heat and power (CHP) (cogeneration) 2

 

 in multifamily 
housing is an initiative of the HUD Energy Action Plan. To help implement it, beginning in 
2003 the Department of Housing and Urban Development (HUD) and the Department of 
Energy/Oak Ridge National Laboratory (DOE/ORNL), executed Interagency Agreements 
(IAA) to create feasibility screening software.  ORNL created, expanded, and validated a 
Level 1 preliminary screening tool that gives the owners of multifamily housing a coarse 
assessment of the feasibility (cost, savings and paybacks) for installing CHP. HUD gave 
training and promoted its use by HUD staff, housing associations, and building managers.    
In May 2010 ORNL created for HUD a more refined Level 2 Multifamily CHP Analysis 
Tool (MF CHP) that adapts the Building, Heating, Cooling, Power (BCHP) tool used for the 
Federal Energy Management Program (FEMP) for use on multifamily buildings. The Level 2 
analysis will help an owner determine whether to invite proposals for design of a system and 
for a financial analysis.  Here is an introduction to the new software program, with a 
description of its development and advice on how it can be used. This includes material from 
the June 17, 2010 ORNL training webinar and a brief introductory exercise to the MF CHP 
Tool. 

What is the market for a Level 2 CHP Analysis Tool?  One assessment is that the tool is 
designed for engineers and designers of HVAC systems, not for the general public.  This would 
certainly include the eight DOE Clean Energy Regional Application Centers (RACS)3

 

. Another 
view is that facility managers / developers / engineers / property owners could all make use of it 
with some assistance by someone familiar with building simulation. The main benefit will be 
providing a consistent tool as a base for analysis, instead of individual customized spreadsheets. 

                                                      
1 [NOTE: This Guide was edited by Robert Groberg, Sr. Energy Management Officer, HUD, CPD, OEE.          
Much of the following text is drawn from MacDonald, Michael, “BCHP Screening Tool Users Manual, Version 2, 
November 2007”  and  “MF CHP Level 2 Analysis Tool –User Manual,” May 2010 by Piljae Im, both of the Oak 
Ridge National Laboratory.]     
2 Combined Heat and power (cogeneration) is the production of electricity on site and use of the heat created in that 
process that can achieve overall efficiencies of about 80% compared to the 45% of central power stations. [See EPA 
http://www.epa.gov/chp/ and DOE  http://www1.eere.energy.gov/industry/distributedenergy/ web sites with  basic 
information on CHP.]   For profiles of CHP installed in multifamily housing, see:  
 http://www1.eere.energy.gov/industry/distributedenergy/projects_sector.html#multifamily  
3 http://www1.eere.energy.gov/industry/distributedenergy/racs.html   RACS promote clean energy technologies 
and offer assistance for regional projects throughout the US. 

http://www.epa.gov/chp/�
http://www1.eere.energy.gov/industry/distributedenergy/�
http://www1.eere.energy.gov/industry/distributedenergy/projects_sector.html#multifamily�
http://www1.eere.energy.gov/industry/distributedenergy/racs.html�
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Advice for Users of Level 2 Tool. The MF CHP User’s Manual (page 2-4) has this advice:  
“Enhanced abilities for simulating building energy use are needed since the energy flows in 
buildings are complicated, and difficult to calculate at the level needed for reasonable analysis of 
CHP systems.  Thus the aid of a building energy simulation tool is important.”                            
[A building simulation professional can help to understand what is happening during the 
operation of the tool and use it effectively. Ed.4

“The Tool handles input and output for users and creates extensive default inputs for the default 
building types via the ‘Template’ file.  Key outputs are extracted and made available in the main 
Table tab or the graphic user interface (see Figure 1 above).  

] 

As indicated in the MF CHP User’s Manual (page 2-6, Using the Tool) “An implied skill 
important to improving results obtained with the MF CHP Analysis Tool is ability to understand 
building energy use and simulation of that use.  However, users with no skill at all can generate 
results using this tool, so be cautious about results generated before developing experience with 
the simulation results and how to change them.”   

                                                      
4 General building energy modelers can be found in the A/E firm or consulting firm. They perform 
building energy simulation modeling for new and existing buildings for the purpose of building 
equipment sizing, code compliant simulation, LEED certification, etc. Recently, ASHRAE developed the 
Building Energy Modeling Professional certification.  See: http://www.ashrae.org/certification/page/2491 
with a list of the certified professionals in the website. But this list is the just little portion of the whole 
building modelers since the certification program is relatively new. 

 

https://email.hud.gov/OWA/redir.aspx?C=425a2a93e2d64cc29c959ebcf6a573e7&URL=http%3a%2f%2fwww.ashrae.org%2fcertification%2fpage%2f2491�
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II.   UNDERSTANDING FEASIBILITY SCREENING FOR CHP 
Background: How does the Level 1 Tool work?  Using monthly utility costs and rates and 
some basic information about a building’s size, occupants and equipment, the Level 1 Tool 
provides a coarse economic assessment of the feasibility of installing CHP powered by natural 
http://eber.ed.ornl.gov/HUD_CHP_Guide_version_2.1.     
It is linked to HUD CHP Guide #1, Q&A on CHP for Multifamily Housing” and #2 “Level 1 
Feasibility Screening”   at   www.hud.gov/offices/cpd/library/energy/index.cfm .      

It is also cited by EPA’s Local Climate and Energy Guide.  5

The best prospects are buildings with at least 80 units and master-metered for electricity.

   
6

HUD public and assisted multifamily housing and HOME program guides recognize the Level 1 
Tool.  HUD demonstrated and promoted its use on line, in HUD programs and with housing 
associations and building managers. This stage also involved the eight DOE-supported Clean 
Energy Regional CHP Application Centers.  The effort is described in a paper delivered at the 
2008 ACEEE Summer Study on Energy Efficiency in Buildings.

 The 
tool was characterized as “user friendly” by a manager for one of the larger non-profit assisted 
housing owners who downloaded and applied it. A major CHP engineering, monitoring company 
found the final version “closest to what their analysis produced”.  Building owners can decide 
whether the potential payback is attractive enough to warrant proceeding to a more precise Level 
2 analysis.  

7

 

   

How does a Level 2 Analysis Work?  A Level 2 analysis is based on detailed site examination, 
hourly utility usage and heat consumption.  The key is that there is a much more thorough 
analysis of annual heating and cooling loads, building electrical loads, and CHP system 
performance performed in a Level 2 tool and it does a much more rigorous calculation of dollar 
savings. It eliminates simplification errors associated with using monthly building averages by 
capturing hourly fluctuations in building performance. These capabilities are especially 
important in determining the potential benefits of CHP. But this analysis can cost $5,000-10,000 
in engineering charges. One means of keeping the analysis costs down is to provide a Level 2 
tool for owners and for analysts that can facilitate the effort.   

 

 

 

                                                      
5 http://www.epa.gov/statelocalclimate/documents/pdf/combinedheatpower.pdf  
6 See: HUD CHP Guide #2, page 15 Checklist.  
7  Groberg, MacDonald and Garland, “Promoting Combined Heat and Power (CHP) for Multifamily Properties,” 
2008 ACEEE Summer Study on Energy Efficiency in Buildings: SCALING UP:  Building Tomorrow’s Solutions. 
[See www.hud.gov/  linked above for this paper; click “pdf”.] 

http://eber.ed.ornl.gov/HUD_CHP_Guide_version_2.1�
http://www.hud.gov/offices/cpd/library/energy/index.cfm�
http://www.epa.gov/statelocalclimate/documents/pdf/combinedheatpower.pdf�
http://www.hud.gov/�
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The ORNL already has a Level 2 Tool: Building Cooling, Heating and Power (BCHP) Screening 
Tool used widely in the Federal Energy Management Program for federal installations:8

http://www1.eere.energy.gov/femp/technologies/derchp_chpscreenings.html

  

   

In addition to federal facilities, the BCHP screening tool can serve fourteen building types (e.g. 
hotels, office buildings, hospitals and nursing homes).  But BCHP does not contain screens for 
multifamily housing.  According to ORNL, “the original tool was developed only for 
commercial buildings. The multifamily building is something between commercial and 
residential building types, so the original developer may not have included the multifamily 
building as one of the options.  The other building types cannot be used for the multifamily 
simulation since all the default values and schedules from the other buildings are quite different 
from multifamily ones. The diurnal load profile in multifamily housing is unique and 
significantly influential in CHP analysis.  That is why ORNL developed the multifamily option.”  
In addition, the multifamily tool now has updated generator database and other improvements. 

 

The differences between the two levels were outlined for HUD in 2008:9

“The hourly calculations give the MF CHP Screening Tool several significant capabilities that 
the HUD Level 1 program does not have: 

 

1) “BCHP uses building dimensions, materials, insulation, internal heat and humidity loads, etc. 
with ’typical’ weather conditions to calculate heating, cooling, and hot water loads. The HUD 
program makes much cruder estimates of those loads from the energy consumption information 
from a single year's electric and fuel bills.”  

2) “BCHP uses a database of operating efficiencies and cost parameters for generating 
equipment. Fuel consumption is adjusted for part load and temperature dependent variations.) 
The HUD program uses curve fits to the full-load steady-state efficiency to estimate fuel 
consumption and curve fits for first cost and operating and maintenance costs.”  

3) “BCHP uses a database of heating and air conditioning equipment to estimate electrical 
consumption for a typical year's operation while the HUD program uses a single built-in 
assumed annual operating efficiency for boilers, water heaters, and air conditioning.” 

4) “The BCHP Screening Tool has "typical" commercial building types (e.g. hospitals, retail 
store, office building) built into it for the user to select. These building configurations were 
developed by Lawrence Berkeley Laboratory for the Department of Energy and are based on the 
U.S. inventory of commercial buildings.” 

 
                                                      
8 BCHP can be used to evaluate conventional energy conservation measures (ECMS) by not specifying a power 
generation system and instead specifying different “cases” of  ECM’s. It can also be used to evaluate more complex 
measures such as reduction of ventilation rate or changes in window type. For more detailed information about the 
BCHP Screening Tool Program Installation, including a PowerPoint used for Energy Assessment Training, see: 
http://eber.ed.ornl.gov/bchpsc/  For further information contact Melissa Madgett by e-mail at madgettmg@ornl.gov 
9 Comparing Level 2 BCHP to Level 1 HUD Feasibility Screening tool for Combined Heat and Power,                
(February 21, 2008).  Per Steve Fischer, ORNL, retired. 

 

http://www1.eere.energy.gov/femp/technologies/derchp_chpscreenings.html�
http://eber.ed.ornl.gov/bchpsc/�
mailto:madgettmg@ornl.gov�
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III.  DEVELOPING THE HUD LEVEL 2 TOOL 

 One “Major Challenge” identified in the ACEEE paper cited above (footnote 4) was “Making 
the more advanced (Level 2) ORNL BCHP software ready for use for apartment buildings.” 
Continuing their joint effort with another IAA in 200910

1) Developing the criteria for the tool capabilities, including the “adaptable multifamily 
building model”; 

, HUD commissioned ORNL to adapt 
BCHP for use for multifamily housing, including development of standard input files that owners 
or analysts should only have to modify slightly. The five completed tasks were:  

2) Updating the BCHP Screening Tool to a beta version of the defined capabilities; 

3) Testing the beta version using data to be provided by HUD on specific properties to 
verify the types of results achieved and determine refinements needed. This testing task 
was used to develop a “reference case” of data for the tool that serves as the default 
multifamily building startup scenario;  

4) Developing a multifamily-specific User Manual; and 

5) Providing training in the use of the new tool.    

 

Review and revision of the beta version.  A beta version of the MF CHP Level 2 Analysis Tool 
(MF CHP) was prepared and shared with reviewers from the CHP industry and the DOE 
Regional Clean Energy Centers. Here are a few more common review comments:  

1) “Generally, the model contains much more detail than should be necessary for 
multifamily CHP screening, and thus takes way too long to use. …There's no way I'd 
have time to plug a complete model of a system we've built or proposed at the level of 
detail the model requires.” (ESCO) 

2) “Default utility rates have changed a lot since 2002-3 and should be updated to 2008-9.  
But, since rates are so different around the country, is a default rate even of any use? 
(Engineer) 
 
3) “Equipment keeps changing with new manufacturers entries into the market and with 
product changes, improvements from existing manufacturers. A listing helps but the 
assessor should be told to check the latest available equipment.  Most equipment now 
requires a higher rate of fuel input per kWh developed than it did several years ago due to 
more stringent effluent restrictions. (Engineer) 
 
4) “I found those ‘HELP’ descriptions very well done and concise. It was nice not to have 
to open up another window to see them. Adding a few more (such as in the Utility 
Selection section) would be good.  The results I was getting with the ’electric demand’ 
generation option were reasonable and seemed to track changes to the generator sizing in 
a manner that was anticipated. “(Engineer) 

                                                      
10 DOE Proposal 2094-V170-09. HUD IAA I-OPC-23500 
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Based on the reviewers’ feedbacks and other needs, several changes, were made. The key ones 
dealt with the input screen, utility rates and defaults for multifamily buildings.  
Input screen layout. The original BCHP and the MF CHP tool beta version had 19 input categories and 
each input category has several input parameters. Users were asked to input all the input values, which 
can be too complicated and time consuming procedure. Beta version 3 has 7 mandatory input 
categories and 5 optional input categories. For quick simulation, users are asked to input only the 
mandatory input portion. Advanced detailed simulation can be performed using all the optional input 
categories.   For the list of Mandatory Inputs, see below. 

 
Mandatory Inputs 
1.  Scenario Description 
    a.  Descriptive Summary 
    b.  Building Type 
    c.  Peak Date Shown 
2.  Building Input 
    a.  Location 
    b.  Length of Building 
    c.  Width of Building 
    d.  Number of Floors 
    e.  Basement Present 
    f.  Story Height 
    g.  Building Rotation 
3.  Construction Details 
    a.  Wall Structure 
    b.  Wall Insulation (R-value) 
    c.  Roof Structure 
    d.  Roof Insulation (R-value) 
    e.  Window Type 
    f.  Window Overhangs 
4. System Selection 
….a. System Type (HVAC type) 
....b. Fan Type   
     c. Air Handler Layout   
     d.  Economizer 

 
 
5. Equipment Selection 
    a.  Lead Space Cooling  
    b.  Lag Space Cooling 
    c.  Desiccant System 
    d.  Heating Boiler 
    e.  Service Water Heater 
    f.  Generator 
    g.  Chilled Water Pumps 
    h.  Hot Water Pumps 
    i.  Cooling Tower 
    j.  Cool Storage 
    k.  Hot Storage 
6.  Generator Detail 
    a.  Number of Generators 
    b. Generator Sizing (as Peak %) 
    c.  Generator Sizing (direct input) 
 
7.  Utility Rates 
    a.  Standard Electric Rate 
    b.  Standard Gas Rate 
 
 

 

 
 
Utility Rates. The previous version has a complex utility rate structure by utility company 
and location. However, the whole set of utility rates is out of date. Beta version 3 has only 
standard (or blended) single utility rate for electricity ($/kWh), and Natural Gas ($/Therm). 
Users are asked to input the rate directly. If user needs to do the calculation based on 
complex utility rates (e.g., peak demand, block charge, etc.), the hourly or monthly energy 
use can be generated from the tool, and the utility cost can be calculated outside of the toolkit 
using spreadsheet, etc. Default value in the tool is from the 2008 national average rate. 
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Building Defaults for Multifamily Buildings.  All the building space default values were 
updated for multifamily buildings based on numerous resources. Those are: 

- ASHRAE Standard 90.1 – 2004;  
- ASHRAE Handbook of Fundamentals;  
- Residential Energy Consumption Survey (RECS) 
 - “Estimating Water Heating and Aggregate Electricity Loads in Multifamily 
Buildings,” R. L.  Ritschard, Y. J. Huang, J. M. Fay, ASHRAE Transactions 1990, 
Volume 96, Pt. 1, pp. 796-802 
- “Impact Evaluation of the Energy Retrofits Installed in the Margolis High-Rise 
Apartment Building, Chelsea Housing Authority” M.M. Abraham, H.A. McLain. And 
J.M. MacDonald, Technical report ORNL/CON-413, 1995.  
- Plus professional judgment 
 

  
 

IV.DESCRIPTION OF THE DEVELOPED MF CHP LEVEL 2 TOOL BETA 3 
 

The MF CHP Level 2 Analysis Tool consists of the executable program, databases for 
HVAC equipment, electric generators, thermal storage systems, prototypical multifamily 
buildings, and weather data. The program also includes DOE-2.1e to calculate heating, 
cooling, and electrical loads.  DOE-2 is a widely used and accepted freeware building energy 
analysis program that can predict types of buildings. DOE-2 uses a description of the building 
layout, constructions, operating schedules, conditioning systems (lighting, HVAC, etc.) and utility 
rates provided by the user, along with weather data, to perform an hourly simulation of the building and 
to estimate utility bills. DOE-2 simulates at an hourly time step, so data are available down to the 
hourly level. 

 

Use of DOE-2 in the MF CHP Level 2 Analysis Tool. The original program, the BCHP 
Screening Tool, was developed under Department of Energy funding by a collaborative 
effort between GARD Analytics of Park Ridge, Illinois and Oak Ridge National Laboratory 
in Oak Ridge, Tennessee. GARD Analytics delivered a fully-functional version of the 
program in October 2003 which has subsequently been modified by ORNL to incorporate 
graphical interfaces for data input and output.    

The engine for the MF CHP tool is DOE-2.1, which is one of the most well known building 
energy simulation programs, and the origin of the eQuest simulation program, which is one 
of the most widely used building simulation programs in the building energy industry.   
 
The MF CHP Analysis Tool runs DOE-2.1e in the background, using another powerful tool 
that provides all the input options, executes the other programs needed, and manages the 
production of results. 
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The MF CHP Level 2 Analysis Tool is structured to perform parametric analyses between a 
baseline building, typically a conventional building without a CHP system, and up to 25 
alternative scenarios with varying selections for building mechanical systems and operating 
schedules.  The current Beta version has only standard (or blended) single utility rate for 
electricity ($/kWh), and Natural Gas ($/Therm). 

 

 How to access the MF CHP Level 2 Analysis Tool.  The current working beta version 
(beta 3) was completed in May 2010, and can be downloaded from the Oak Ridge Lab web 
site along with the DOE-2 documentation, the 107 page Users Manual and the training 
PowerPoint material:    http://eber.ed.ornl.gov/MF_CHP 11

 

 

How the MF CHP Level 2 Tool Works. The tool handles input and output for users and 
creates extensive default inputs for the multifamily building types via the “Template” file.  
Key outputs are extracted and made available in the main Table tab or the graphic user 
interface.     

There will be three components in the analysis: 

1. Develop an initial simulation which is an as-built building simulation using the 
provided information. 

2. After initial simulation, if the results will be different from the utility bill data, which 
often happens in simulation procedure, then the initial simulation should be modified 
to match with the utility data.  This procedure is called “calibration.” This is 
illustrated in the training material.  

3.  Finally, generators will be applied to the calibrated building simulation to investigate 
the feasibility of the system.  Iteration will be required to determine the optimum 
generator sizing, combinations, and operations.   

 

See Figure 1, below, for the general process and sequence of steps in the use of the tool.  

                                                      
11 The computer system requirements are OS: Microsoft Windows XP, Vista, and 7.  ORNL has not 
tried to install the program on the machine with Windows 2000, but is sure it’ll work on that OS. 
HDD: At least 100 MB available space. Except above, CPU speed and RAM capacity would be no 
problem with most of today’s specifications 

http://eber.ed.ornl.gov/MF_CHP�
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Figure 1: Sequence of the MF CHP Level 2 Analysis Tool 

 
 

The nine steps in the Figure above cover the following activities: 

(1) The input parameters –building and equipment information—will be put into the pre-
developed DoeRayMe (DRM) Template. (2)   DRM is the file format of the building 
description for the tool. 

-The DRM Template then will generate the fully functioned DOE-2 Building Description 
Language (BDL) file (3) (which is the DOE-2 input text file); 

-Then there will be two sets of simulations run, (4) DOE-2 run  and (5) output  for system 
sizing (such as chiller, boiler sizing) and then (6) run and (7) output for full 8760 hours of 
simulation; 

-Again, the output from the simulation will be extracted using (8) the DRM template, and be 
shown on the tool (9), so users can see and use the results. 

Input through the 
MF CHP Tool (1) 

DRM Template (2,8) 

DOE-2 BDL File (3) 
(DOE-2 Input File) 

DOE-2 Run for 
System Sizing (4) 

Output for 
System Sizing (5) 

DOE-2 Simulation 
Run (6) 

DOE-2 Simulation 
Output (7) 

Output in the MF 
CHP Tool (9) 
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The procedure for the Level 2 Analysis involves the base case, initial run (as built), 
calibration of the base case to reconcile with actual data; application and changing generator 
options, and finding the optimal scenario. At least the Mandatory Inputs should be entered. 
Use available data/information. Use best guess for unknown data/or leave default values for 
average multifamily building characteristics, unknown parameters (e.g., window-to-wall 
ratios, boiler and chiller size, operation schedule) equipment performance data and actual 
weather versus typical weather file. Following this a calibration will be needed to reconcile 
guessed entries with known data (e.g. actual utility consumption). 

 First, when you run the program, you will see the screen like Figure 2 below, with three 
portions to the screen:  Input, Results and Help.  Columns A and B provide for two scenarios, 
e.g. one without and one with a generator to provide some of the heat and power for the 
building. Columns are added as you choose additional scenarios. Four tabs enable showing 
Inputs and Outputs as tables, schematics and building description. Inputs can be made 
directly, chosen from a drop down menu, or selected from a separate window. There are 
input screens for adding data (Mandatory Input --page 4 above-- with 7 categories for a quick 
run, and Additional Input with 64 categories for a thorough analysis).  

 

Figure 2. Three basic screens, four tabs and two scenarios.  
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Output screens can be in the form of graphs or a schematic summary of energy (gas and 
electric) flow, summary of calculated project cost, operating cost, annual savings and simple 
payback 

 

 

Figure 3. Output Screen 

Cost Analysis System 
Configuration

Space and SW 
HeatingHeat Recovery 

Summary 52
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The most useful summary array of results may be the following: 

 

Figure 4. Results Displays 

 

Overview of the BCHP Screening Tool
• Results

– Annual Gas and Electricity 
Consumption & Costs

– Equipment Sizes & Costs
– System Life Cycle Costs
– Parametric Analysis of Up to 26 

Systems
– Simple Payback Relative To 

Baseline
System

– Hourly Load Profiles for Selected 
Dates

Building Loads: Dec-15
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There are some 17 other screens that deal with calibration, changes to input, output (annual 
consumption), adding generators, checking outputs and “next steps” (analyzing and finding 
the optimal generator and schedule for the building). The 107 page User’s Manual provides 
detailed guidance. 
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V. ADVICE FOR USERS 
 

In addition to the cautionary advice provided on pages 3 and 4, ORNL has identified some 
limitations and issues in Beta 3. Some key items are: 

• Complicated utility rate structures may be simulated with simpler transforms. 
• Life-cycle economic data such as fuel price escalation factors have not been 
updated, so life cycle economic results must be approached with caution — simple 
paybacks are not affected. 
• Desiccant systems do not appear to allow use of recovered heat from CHP systems, 
and changes appear necessary to correct the algorithms. 

 
Other issues identified by reviewers of the Tool and this Guide include: 

 
• Some graphs don’t properly display electric cost savings.   
• The detailed utility structure is too complicated in this level of analysis;  only the 

blended standard rate ($/kWh and $/therm) will be enough, and possibly peak 
demand can be added.  One another option is adding the website address in the tool 
for users to find the utility rate in their region in real time. The 2008 average utility 
rate is shown in the tool as a reference, but users need to be able to put in their own 
utility rate, which can be easily identified from their utility bills. The big utility rate 
data base is not adequate since it’ll change overtime.  

• The results on the main screen are pretty detailed,  and  they could be divided first 
into  Key outputs and then Additional outputs in a similar fashion with the input 
screen (i.e., mandatory inputs then additional inputs). 
 

• It would be useful to identify a website for the real time utility cost. 
 

HUD is exploring with ORNL the possibilities for another agreement to deal with these 
limitations and the provision of data on additional multifamily building types and locations. 
 
Use of MF CHP for other Energy Conservation Measure (ECM) Analyses. The MF CHP 
tool can control most of the detailed input parameters for the DOE-2 building energy 
simulation. Therefore, the tool surely can be used for other ECM analysis such as better 
insulation, better windows, changing the lighting system, replacement of chiller, boiler, and 
much more. This feature may be of use to those considering combining a CHP project with 
other building upgrades.  In such cases, the interactive effects of multiple ECMs and a CHP 
project will likely affect generator selection and economics. 
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The "plain" DOE-2 program is a "DOS box" or "batch" (or Command console) program that requires 
substantial experience to learn to use effectively while offering researchers and experts significant 
flexibility. The DOE-2.1e version of the program used in the MF CHP Level 2 Analysis Tool runs in 
the "background" of the graphic interface for the tool.  Documentation on the DOE-2.1 program can 
be downloaded either from the BCHP website or 

http://doe2.com/DOE2/index.html#doe2le under DOE-2.1E Documentation files. 

Users may also wish to check the website   http://simulationresearch.lbl.gov/  

Providing access to DOE-2 gives multifamily housing owners and managers a powerful tool 
for analyzing a wide range of potential energy conservation measures in addition to 
combined heat and power.  These are typically considered in energy audits and for energy 
performance contracts involving public housing agencies. These measures are important to 
establish a proper base for calculating the size and operating time for CHP systems. 

 

 

 

 
Feedback/questions/comments on MF CHP should be sent to:  

Piljae Im, Ph.D.                               
R&D Staff                     
Residential, Commercial & Industrial Energy Efficiency  
Energy and Transportation Science Division   
Oak Ridge National Laboratory  
Tel. (865) 241-2312 
Fax. (865) 574-3851 
imp1@ornl.gov 

http://doe2.com/DOE2/index.html#doe2le�
http://simulationresearch.lbl.gov/�
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APPENDIX 

A BRIEF EXERCISE TO INTRODUCE THE USER TO THE MF CHP 
LEVEL 2 ANALYSIS BETA VERSION 

The MF CHP Level 2 Analysis Tool was designed to be simple to use but making it easy 
for you to use is what really matters.  Here is a brief introduction to understanding how the 
Tool works [prepared by GARD Analytics for BCHPsc]. 

When you first start MF CHP Level 2 Analysis Tool the main screen below (also Figure 2 
above) consists of four tabs labeled Table, Graph, Schematic, and Building Description. 
The Table tab shows you a grid with a list of parameters, their units and the values for two 
alternatives labeled A and B. The Table tab is divided into three portions, Input, Result and 
Help. The Input area contains parameters that you change depending on the building and its 
systems. [There are the seven “Mandatory” categories followed by the “Additional 
Inputs” with 64 categories ] Result shows the results of a simulation and Help shows 
you some information about each row in the Input and Result areas. The lines separating 
the Input, Result and Help areas can be moved up and down to allow you to see the area 
that you are most interested in. 
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Try clicking on different lighter colored boxes in the Input grid under columns A or B. 
The Help area on the bottom should change for each row to show you some information 
about that row. Depending on the row, you can pull down a list of choices, enter a value, or 
click a button that takes you to a selection screen. Although there are many input rows, for a 
quick simulation, you need to complete only Mandatory Inputs.  
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You can add more alternatives by using the Insert menu. Each new alternative is 
shown by a new column in the grid. For the parameters that show a list of values, try 
selecting different choices. 
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Now press the Run button at the top of the window. You will notice another 
window on your screen will open showing the activities of DOE2 (another program 
that actually performs the simulation of the energy use in the building). Each 
alternative needs two simulations, first a short simulation for sizing equipment and 
then a longer hour-by-hour annual simulation. When this is done, check the 
simulation results in the results section — are they different? 

Try changing the building location or another parameter and pressing the Run 
button again. Does the cooling and heating energy change? 
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Try out the Graph tab. The graphs, also called charts, can be monthly results or annual 
results from the simulation. The controls to select what is shown on the graph are in 
the lower part of the window. The numbers shown on the graph are taken from the 
grid on the Table tab, but are now being shown graphically. This is a quick way to 
see the impact of changing some parameters. 

 

 

 



HUD CHP Guide #3- Introduction to Level 2 Analysis Tool for Multifamily Buildings                    22 
 

 

 

The Schematic tab provides a good summary of the energy (elec. and gas) flow 
based on the selected case. It also shows the summary of calculated project cost, 
operating cost, annual savings and simple payback.  

 

 

 

 
 



HUD CHP Guide #3- Introduction to Level 2 Analysis Tool for Multifamily Buildings                    23 
 

 

 

Select Building Description tab when you want to see the building/zone 
characteristics such as floor space, window area, internal load and building schedule 
by zone. 

 

 



HUD CHP Guide #3- Introduction to Level 2 Analysis Tool for Multifamily Buildings                    24 
 

 

 

Now to save your work press the Save button and give the file a name. You can even 
have multiple files open at once. To have another blank template with default values  
open, select File and then open BCHP Screening Tool Template. 

 

 

Try experimenting with other features on the menus and with changing parameter values 
and running the simulation. Believe it or not, you have already learned about 75% of the 
features in the MF CHP Level 2 Analysis Tool. Experiment some more with different 
parameters until you become comfortable with these features.  

      #### 

             September 1, 2010 
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